Introduction

Dear customer,

we would like to thank you for purchasing this product. This product complies with legal, national and European requirements. To maintain correct working condition and safe operation, you as user must obey this instruction manual at any time!

The "CONTROLLINO Open-Source PLCs", or microcontroller as you might also call them, are modern programmable control systems that are offered in a variety of different versions. They were developed by us with the aim of fulfilling the high expectations of our customers on product quality and functionality.

IMPORTANT! Read this instruction carefully before working with this product. It explains the correct usage of the product and indicates possible dangers. Observe all operating and maintenance instructions. Damages resulting from the non-observation of this manual do not constitute a warranty claim and CONELCOM GmbH does not accept any liability.

All company, brand and product names in this publication belong to their respective owners. All rights reserved.

Please direct all technical questions to:

CONELCOM
Controls - Electronics - Communication

CONELCOM GmbH
Trientlgasse 18c
6020 Innsbruck / Austria
Telephone: +43 (0) 664 4752266
Email: info@controllino.biz
Guarantee

Each and every CONTROLLINO leaves our premises in flawless condition. All functions were thoroughly tested.

CONELCOM GmbH does not take any responsibility for consequential damages to people or assets that are caused by the use of CONTROLLINO.

Box content

1x CONTROLLINO (according to your order: MINI, MAXI or MEGA)

These symbols are used in this manual and on the device

- !: ... Read the documentation before using the device

- 🔥: ... Hot surface, please read section “Ambient temperature”, page 10
**Intended use**

The CONTROLLINO PLC is a small computer (\(\mu\)C = microcontroller) with peripherals based on the "Open-Source Arduino platform". It is installed in a DIN rail housing.

With this product various control and automation tasks can be solved. You have to create appropriate programmes to do this.

On the manufacturers website of CONTROLLINO (http://www.controllino.biz) you will find various demo programs and libraries that will get you started with programming.

For the connection of external sensors and devices always mind the corresponding sections in this manual.

Any use other than described in this manual is not permitted. Besides possible damages to the device, this is also associated with dangers like short circuit or electric shock.

The CONTROLLINO PLC must not be altered or modified. The safety instructions as well as the maximum permissible operating and ambient conditions given in the chapter "technical data" must be observed.

Read the whole instruction manual carefully and attentive. It contains important information on mounting, operating and handling your CONTROLLINO.

**Information on the manufacturer and on CONTROLLINO controllers can be found here:**
http://www.controllino.biz
Safety Instructions

In case of damage caused by non-observance of these operating instructions the warranty will be voided! We will not accept any liability for damages.

In case of damage to property or personal injury caused by improper use or neglecting the safety instructions, we will not accept any liability! In such cases the guarantee / warranty will be voided!

- For safety and authorization reasons (CE) any unauthorized modification and / or alteration of this product is not permitted.

- Do not use this product in hospitals or medical facilities. Do not use the product in safety-relevant areas.

- Switch off the supply voltage of this product as well as of attached devices before connecting or disconnecting them.

- Do not operate the product in an environment with easily inflammable objects, liquids or gases or in explosive areas.

- Make sure that all electrical connections, connection lines between the device and possibly other extension lines are set up according to regulations and in accordance with the instruction manual.

- Never operate the unit immediately after taking it from a cold into a warm room. This might lead to water condensation within the unit, which could possibly destroy it.

- The product is mounted in a housing for DIN rail mounting (top hat rail). To ensure safety, at 230V~ and relay voltages greater than 24V the module must be operated only in a closed control cabinet or in a control box with veneer connection terminals.

- The product is connected to other devices via its connection terminals (screw terminals). The low-voltage terminals and the relay terminals for 230V~ need to be distinguished. In case of an accidental mix-up there is potential fire hazard through shorts. This might damage the device and connected modules!
• In case you should not be aware of the correct connection, or if any questions should arise about the functioning, the safety or the connection of the device that are not taken care of in the instruction manual, please contact our technical hotline or a specialist.

• In schools, training institutions, hobby and business self-help workshops, the operation of the product must be supervised by trained staff.

• In commercial facilities, the accident prevention regulations of the Association of Professional Trade Associations for electrical installations and equipment need to be observed.

• Do not litter packaging material, it might become a dangerous toy for children.

• If the equipment is used in a manner not specified by the manufacturer, the protection provided by the unit may be impaired.
Installation

For its proper use, CONTROLLINO PLCs must be mounted on a DIN rail, for example in a distribution box that is used for housing circuit breakers and relays and is commonly used in any home installation.

- Electronic components of the product can become warm during operation. Take care to prevent heat accumulation through proper air circulation around the unit.

- Do not mount the unit in insulating material or next to heat sources such as heating pipes, radiators or electrical products such as motors or similar products. Mind the maximum temperature specifications in the technical specifications!

- The product must not be operated or mounted in or under water.

- Be careful when drilling or tightening cables or wires in order not to damage them.

- During the mounting process, make sure that no moisture, water, dust or dirt gets inside the housing. This might destroy the product!

- Mount the carrier system first, for example the distribution box.

- Arrange the CONTROLLINO controls and other assemblies in your overall application in the distribution box. Installation is done simply by snapping the modules onto the DIN rail. Important distances:
  Distance from CONTROLLINO to front side of enclosure shall be min. 10 mm,
  Distance from CONTROLLINO bottom to the bottom side of enclosure shall be 20 mm,
  Distance from CONTROLLINO to another components min. 50 mm to other DIN rail.
  Distance from CONTROLLINO to another components min. 0 mm on the same DIN rail.
  Distance from CONTROLLINO to the enclosure min. 30 mm

- The unit can be in vertical or horizontal position.

- The unit shall be installed in enclosure which meets requirements for fire and electrical enclosure.

- If necessary let your overall installation be checked by a competent person (electrician)!
Connection and operating elements

The CONTROLLINO PLCs are equipped with screw terminals for the connection of external components. The wire strength for the screw terminals at the bottom should have a recommended cross-section.

Model MINI
For supply conductors: DC 24 V use of 1mm² to 2,5mm² (AWG16 to AWG13), with temperature rating at least 90°C.

Model MAXI
For supply conductors: DC 24 V use of 2,0 mm² to 2,5mm² (AWG12 to AWG13), with temperature rating at least 90°C.

Model MEGA
For supply conductors: DC 24 V use of at least 2,5 mm² to 4mm² (AWG12 to AWG 12), with temperature rating at least 90°C.

All models
For Relay outputs (6 A) use conductors of at least 0,75 mm² to 4 mm² (AWG18 to AWG12), with temperature rating at least 90°C.

For Digital outputs (2 A) use conductors of at least 0,5 mm² to 1,0 mm² (AWG20 to AWG17) with temperature rating at least 90°C.

For inputs and RS485 interface use any kind of conductor cross section due to the small input current with temperature rating at least 90°C.

In addition, the CONTROLLINO PLCs have one or more pinheader connectors with a grid size (RM) of 2.54mm. Here you can attach jackbars with flat ribbon cables or so-called "jump-wire" for experimental setups. The following illustrations show the three types of CONTROLLINO controls and their connection and operating elements.

All connected cables including power cables shall not exceed length of 30 m.

INFO: on http://www.controllino.biz you can download a "PINOUT table". In this table you can easily see all internal wiring between terminals and the microcontroller.
Ambient temperature

MINI for vertical and horizontal position temperature range is 0 - 55°C.

MAXI vertical and horizontal position temperature range is 0-55°C.

MEGA vertical and horizontal position for all digital output load 0,5 A and all relay output 4 A temperature range is 0 - 55°C.
MEGA vertical and horizontal position for all digital output load 0,5 A and all relay output 6 A temperature range is 0 - 50°C.
Figure 1: CONTROLLINO MINI

Figure 2: CONTROLLINO MAXI
Figure 3:
CONTROLLINO MEGA
Supply Voltage Terminal (12 / 24V DC)

The connection "12V / 24V" of the upper terminal block and the adjacent "GND" connection is used for the voltage / current supply of the CONTROLLINO controls. The CONTROLLINO controls can alternatively be operated with a 12V or 24V voltage supply. The permissible supply voltage is 12V (between 10.8V-13.2V) or 24V (between 21.6V-26.4V) (DC, direct current).

IMPORTANT! Please make sure only to use a stabilized supply voltage!

The maximal supply current differs according to the type of CONTROLLINO you are using. You can find it in the following table.

<table>
<thead>
<tr>
<th>CONTROLLINO</th>
<th>used internal fuse</th>
</tr>
</thead>
<tbody>
<tr>
<td>MINI</td>
<td>8A, automotive fuse</td>
</tr>
<tr>
<td>MAXI</td>
<td>20A, automotive fuse</td>
</tr>
<tr>
<td>MEGA</td>
<td>30A, automotive fuse</td>
</tr>
</tbody>
</table>

Exceeding the maximum current would lead to a fusing of the internal fuse of the CONTROLLINO.

The correct voltage supply is indicated by two LEDs with the description "12V" and "24V" on the front panel of the unit. The LEDs light up differently, depending on the supply voltage of "12V" or "24V". The following table shows the states.

The LEDs for the operating voltage states are:

<table>
<thead>
<tr>
<th>12V LED</th>
<th>24V LED</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>green</td>
<td>orange</td>
<td>12V supply voltage active</td>
</tr>
<tr>
<td>orange</td>
<td>green</td>
<td>24V supply voltage active</td>
</tr>
<tr>
<td>orange</td>
<td>orange</td>
<td>supply voltage outside of supported range</td>
</tr>
</tbody>
</table>

INFO: After connecting the supply voltage or pressing the Reset-button CONTROLLINO performs all necessary initializations and then immediately starts the loaded user program.
USB Connector

The CONTROLLINO PLCs can be connected to a computer (USB connection cable type A-B) via the USB port that is attached to the front panel. The socket is protected against polarity reversal. Don’t use too much force when connecting the USB cable!

The main function of the USB port is to program the CONTROLLINO. Inside the CONTROLLINO there is a USB to UART converter which generates a virtual COM-Port on the PC. You can also use this port to give data to a terminal or another program.

"RST" Button and LED

The CONTROLLINO controls can be reset with the "RST" button. The loaded user program is then restarting again. When pushing the "RST" button, the orange LED light with the label "RST" lights up until the button is released. This signals the function of the reset button visually and shows that the PLC has been reset.

The button is located on the front of the CONTROLLINO and is slightly recessed in the housing for reasons of inadvertent actuation. The button must be operated carefully with a small pointed object (e.g. thin screw driver). Do not use too much force – this can destroy the button!

INFO: After connecting the supply voltage or pressing the Reset-button CONTROLLINO performs all necessary initializations and then immediately starts the loaded user program.
"RTC" switch (only at CONTROLLINO MINI)

This switch is made for switching the internal RTC (Real Time Clock) onto the SPI bus. If you use the RTC in your program, the switch has to be in the "1" position, otherwise there would be no data connection to the RTC.

"ETH" connector (only at CONTROLLINO MAXI and MEGA)

The CONTROLLINO PLCs MAXI and MEGA also have an Ethernet connector. It is marked with the sign "ETH". This socket is located on the front of the housing and can be connected via an RJ-45 network plug with a computer network, e.g. a "network switch" or "router" using a 1:1 network cable like CAT5 or CAT7. The two PLCs have a built-in Ethernet chip, type WIZNET W5100, which enables it to communicate over a network (Local Area Network) with other devices such as a computer or another PLC. With this feature, it is very simple to integrate CONTROLLINO into an existing network or to the Internet.

You can use the original examples which are supplied with the Arduino IDE. The CONTROLLINO PLCs are compatible with the "Arduino Ethernet Shield". The Ethernet chip is on the same SPI bus as the RTC, this is why it must be activated via a chip select. If you have installed the CONTROLLINO libraries this is done automatically.

Two LEDs are also integrated in the Ethernet socket to indicate the Ethernet status.

**LED green:** LAN connection active (POWER)
**LED yellow:** Data is transmitted and received
Inputs (A0 to A...)  

The CONTROLLINO PLCs have a variety of digital and analog inputs which are suitable for collecting various data or states. The inputs for analog and digital signals are on the same screw terminals and can be configured and queried differently depending on the application.

Inputs for analog use  

The inputs with the labels "A0" to "A.." are used for the measurement of analog voltage values, based on the mass potential of the CONTROLLINO controls. This allows to measure electrical voltages, for example the output signal of a sensor that depends on certain physical sizes. The data logging works with the internal A/D converter of the microcontroller and has a resolution of 10 bit and delivers values from 0 to 1023.

CONTROLLINO uses an automatic voltage divider internally which is controlled over the supply voltage. Depending on the supply voltage the divider is switched to the right value.

If you use a 12V supply voltage the measured value can be between 0-13,2V.

1 digit = 0,015V (15,0mV)

If you use a 24V supply voltage the measured value can be between 0-26,4V.

1 digit = 0,03V (30,0mV)

The scaling factor is:

<table>
<thead>
<tr>
<th>Operating voltage</th>
<th>Divider ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>@12V</td>
<td>3,06</td>
</tr>
<tr>
<td>@24V</td>
<td>6,14</td>
</tr>
</tbody>
</table>

INFO: all inputs are protected against electrostatic discharging and overvoltage (ESD-protection).
**Inputs as Digital Input**

Each of the digital inputs labelled "A0" to "A.." can also be used as a digital input to measure a switching status. If a logic "1" is measured the corresponding LED "A.." will be active. At a logic "0" the corresponding LED "A.." will be off. This optical information can be used to get a quick overview about the status of the inputs. This can be very helpful when carrying out error diagnostics at a programming stage.

The logic levels depending on the supply voltages are:

<table>
<thead>
<tr>
<th>Logic</th>
<th>Supply Voltage</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>12V</td>
<td>0 to 3,6V</td>
</tr>
<tr>
<td>1</td>
<td>12V</td>
<td>9 to 13,2V</td>
</tr>
<tr>
<td>0</td>
<td>24V</td>
<td>0 to 7,2V</td>
</tr>
<tr>
<td>1</td>
<td>24V</td>
<td>18 to 26,4V</td>
</tr>
</tbody>
</table>

The maximum input current is < 3mA.

**Digital Inputs (I0 to I...)**

These inputs are only digital inputs. If a logic "1" is measured the corresponding LED "A.. " will be active. At a logic "0" the corresponding LED "A.. " will be off. This optical information can be used to get a quick overview about the status of the inputs. This can be very helpful when carrying out error diagnostics at a programming stage.

The logic levels depending on the supply voltages are:

<table>
<thead>
<tr>
<th>Logic</th>
<th>Supply Voltage</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>12V</td>
<td>0 to 3,6V</td>
</tr>
<tr>
<td>1</td>
<td>12V</td>
<td>9 to 13,2V</td>
</tr>
<tr>
<td>0</td>
<td>24V</td>
<td>0 to 7,2V</td>
</tr>
<tr>
<td>1</td>
<td>24V</td>
<td>18 to 26,4V</td>
</tr>
</tbody>
</table>

The maximum input current is < 3mA.
Interrupt Inputs (IN0 and IN1)

In addition to the normal analog and digital inputs, CONTROLLINO PLCs also have 2 special interrupt inputs. This inputs are capable of measuring very fast and important switching operations.

The electrical behaviour is identical to the normal digital inputs. If a logic "1" is detected, the corresponding LED "IN0" or "IN1" is green. The LED does not light up for a logic "0".

The advantage of these inputs is the possibility of trigging and executing subroutines at the change of inputs level. For achieving this, the normal user program is interrupted, and the default routine performs its important tasks, e.g. limit switches, counters etc. After running the interrupt routine, the normal user program continuous.

Digital outputs (D0 to D.. and R0 to R..)

The CONTROLLINO PLCs have "High-Side Switch" outputs, "Half-Bridge" outputs (only MEGA) and potential free relay outputs. Some of these outputs are also capable of generating PWM (Pulse Width Modulation) signals. Therefore it is possible to dim a lamp or to control the speed of a DC motor.

Digital Outputs

The digital "High-Side Switch" outputs and "Half-Bridge" outputs (only MEGA) are labelled with "D0" to "D.." on the upper side of the CONTROLLINO housing. The supply voltage of each of this digital screw terminals can be loaded with 2A @12V or @24V. Each of this outputs are short-circuit proof and limits the maximum output current automatically. The internal resistance when switched is about 70mΩ when using the "High-Side Switch" outputs and about 240mΩ when using the "Half-Bridge" outputs.

INFO: This outputs are not potential free. The load has to be connected between the output and GND. At the "Half-Bridge" outputs you can also put the load between two outputs, to drive for example a DC motor in both directions.

WARNING: these digital outputs are not made to switch 230V.
### Output Parallelization

There is the possibility to parallelize some digital outputs to drive loads with the need of more current under the following conditions:

- Outputs are controlled from the same processor port (possibility to set it via one instruction)
- There is no delay between control signals for parallelized outputs (shall be managed by the SW).

**Possible outputs for parallelization are:**

**MINI:**
- 1st group: D0, D1, D2, D3
- 2nd group: D4, D5
- 3rd group: D6, D7

**MAXI:**
- 1st group: D0, D1, D3
- 2nd group: D2
- 3rd group: D4, D5, D6, D7
- 4th group: D8, D9, D10, D11

**MEGA:**
- 1st group: D0, D1, D3
- 2nd group: D2
- 3rd group: D4, D5, D6, D7
- 4th group: D8, D9, D10, D11
- 5th group: D12, D13, D14, D15, D16, D17, D18, D19
- 6th group: D20, D21, D22
- 7th group: D23

<table>
<thead>
<tr>
<th>Type</th>
<th>Pin Number</th>
<th>Number of Digital Outputs</th>
</tr>
</thead>
<tbody>
<tr>
<td>MINI</td>
<td>D0-D7</td>
<td>8x High Side Switch 2A @ 12V or 24V</td>
</tr>
<tr>
<td>MAXI</td>
<td>D0-D11</td>
<td>12x High Side Switch 2A @ 12V or 24V</td>
</tr>
<tr>
<td>MEGA</td>
<td>D0-D11</td>
<td>12x Half-Bridge 2A @ 12V or 24V</td>
</tr>
<tr>
<td></td>
<td>D12-D23</td>
<td>12x High Side Switch 2A @ 12V or 24V</td>
</tr>
</tbody>
</table>
PWM Outputs

The CONTROLLINO PLCs have PWM outputs (Pulse Width Modulation). These outputs are marked with a dark background and the designation "D0" to "D..". The outputs which are marked with a bright background cannot be used as a PWM output.

The PWM outputs are as follows:

<table>
<thead>
<tr>
<th>Version</th>
<th>PWM Output Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>MINI</td>
<td>D1, D2, D5</td>
</tr>
<tr>
<td>MAXI</td>
<td>D0 ... D11</td>
</tr>
<tr>
<td>MEGA</td>
<td>D0 ... D11, D14, D15, D16</td>
</tr>
</tbody>
</table>

These outputs can be used to control lamps, DC motors or for the output of audio frequencies. Pulse Width Modulation means that a digital output signal is generated, whose duty cycle is modulated. The duty ratio indicates the ratio of the duration of the switched-on state to the period duration. The frequency and the level of the signal always remain the same. It only changes the length from HIGH to LOW.

Current at Digital Outputs

At the maximum ambient temperature of 55°C:

**MINI:**
Digital output max total of all 8 digital outputs is 4 A. That means every digital output can be loaded with 0,5 A at the same time.
One or max 2 digital outputs can be loaded each maximum 2 A but total current of all 8 outputs must not exceed 4 A.

**MAXI:**
Digital output max total of all 12 digital outputs is 6 A. That means every digital output can be loaded with 0,5 A at the same time.
One or max 3 digital outputs can be loaded each maximum 2 A but total current of all 12 outputs must not exceed 6 A.

**MEGA:**
Digital output max total of all 24 digital outputs is 12 A. That means every digital output can be loaded with 0,5 A at the same time.
One or max 6 digital outputs can be loaded each maximum 2 A but total current of all 24 outputs must not exceed 12 A.
Relay Outputs

The relay outputs "R0" to "R.." can be used to connect and switch external circuits. The contact type as well as the contact connections are marked on the PLCs. The maximum permissible switching current per relay is 6A (at 250V / AC) or 6A (at a maximum of 30V / DC). The relay outputs are potential free!

The CONTROLLINO MAXI and MEGA are equipped with LEDs to display the switching status of the relays with the labelling "R0" to "R..". The corresponding LED lights up when the relay is energized.

In case of the CONTROLLINO MINI, the relays are connected parallelly to the digital outputs D0-D5 and thus are named D0-D5.

Each relay output shall be protected by external fuse 250 V T 10 A. Nominal current of relay can be equal or less than 10 A. Maximum voltage connected to relay output: 230 V +10%.

Relay contacts rated load:
- 6 A, 250 Vac  resistance
- 6 A, 30 Vdc  resistance
- 6 A, 250 Vac  General use
- 6 A, 30 Vdc  General use
- 1.5 A, 250 Vac, Pilot duty
- 1 A, 30 Vdc, Pilot duty

Number of relays depending on version:

<table>
<thead>
<tr>
<th>Version</th>
<th>Number of Relays</th>
</tr>
</thead>
<tbody>
<tr>
<td>MINI</td>
<td>6x</td>
</tr>
<tr>
<td>MAXI</td>
<td>10x</td>
</tr>
<tr>
<td>MEGA</td>
<td>16x</td>
</tr>
</tbody>
</table>
**IMPORTANT!** The relay outputs are divided into 2 blocks **Block A / Block B** (figure 4). Due to security reasons, within one block you may only use one type of switching circuit. This means that within block 1, you may only use 230V or DC which is not SELV (Safety Extra Low Voltage) and SELV circuit on block 2 or vice versa. **It is not possible to combine these two types of circuits in one block.**

![Figure 4: Relay Zones](image)

Figure 4: Relay Zones
LED "OVL"

The LED labelled "OVL" signals a thermal overload of the CONTROLLINO PLC. For the CONTROLLINO MINI, two temperature sensors are installed. One temperature sensor is placed on the control board and one on the relay board. If the temperature exceeds 80°C the red "OVL" LED will turn on, indicating a thermal overload.

For the CONTROLLINO MAXI the arrangement of the sensors and their function is the same like the CONTROLLINO MINI. However, with the MAXI the "Overload" signal will also be available at the microcontroller-pin PE7 (Arduino Pin 9). Therefore, you can use this signal in your user program to trigger corresponding actions on how the CONTROLLINO should behave at overload, like a beep or send a message via Ethernet.

At the CONTROLLINO MEGA additional to the thermal control, the "Half-Bridge" driver ("D0" to "D11") also has a FAULT signal which is also connected to the CONTROLLINO general overload signal. If an error occurs (such as short circuit or overload) the "OVL" LED lights up and on PE7 (=Arduino pin 9) the error signal is available (just like with the MAXI). Internal protection functions are provided for undervoltage, charge pump faults, overcurrent, short circuits and overtemperature.

Pinheader Connector (X1 to X...)

Through the pinheader connectors numbered "X1" to "X..." you can connect "directly" to the microcontroller. Theses contacts are like on the ARDUINO board at a 5V level. You can use these pins freely to connect additional modules and electronics. Please mind that the pinheader pins will change their state together with the relays, digital inputs and outputs with the same labelling but on 5V level. These pins are ESD protected.

INFO: You can download a "PINOUT-table" on http://www.controllino.biz. In these files, you can easily see all internal wiring indications between pinheader connector and the microcontroller.
RS485 Interface

The CONTROLLINO PLCs MAXI and MEGA have an RS485 interface type SN65HVD08, which allows it to communicate with other RS485 devices. The RS485 is an interface-standard for digital, line-connected and differential serial data transmission. Connection to the interface is possible via screw terminals. It can carry signals up to about 1.200 metres with 32 subscribers. There is a large number of different components on the market that have an RS485 interface – they can communicate with the CONTROLLINO PLCs.

The RS485 driver module is connected to the UART3 (TxD3 / RxD3) of the ATMEGA2560.

**INFO:** You can download a "PINOUT-table" on http://www.controllino.biz. In these files, you can easily see all internal wiring indications between clamps and the microcontroller.

You will also find an example there on using the RS485 interface.

RTC (Real Time Clock)

Every CONTROLLINO has a built-in RTC of the type RV-2123-C2-TA-QC-020 with buffered power supply. The RTC also runs without external power supply for about 2 weeks. So after a loss of supply voltage you don’t have to reconfigure the time. In the user program you can set hour, minute, second, day, weekday, month and year. These values can be prompted and can be used directly or in logical combination with other conditions as a trigger for specific operations.

**INFO:** An example on using the "RTC" can be found on http://www.controllino.biz.
Software and Initial Startup

The programming of the CONTROLLINO determines its way of functioning. The CONTROLLINO PLCs offer a high degree of flexibility and can therefore be used for many different purposes. Once programmed, your CONTROLLINO provides its service, e.g. as temperature control, light control, alarm system or house control. In case that other tasks are desired, the CONTROLLINO PLC can be reprogrammed as often as required.

Inside the CONTROLLINO works a microcontroller. This is a small computer on a chip which includes the program and memory as well as various other peripherals. Through the FLASH technology the user program is retained even if the operating voltage is disconnected from the system. The programming of the CONTROLLINO is done with the help of the "Arduino IDE" in the popular Programming language "C".

Install Arduino

Before using CONTROLLINO and start programming it, you have to do various preparations. These include installing the drivers for the virtual Com port (Serial interface) on your PC and the installation of the programming / development environment for Arduino. Therefore first download the current Arduino IDE from the Internet.

You can download the ARDUINO IDE here:
http://www.arduino.cc

Download the Arduino Software

Figure 5: Download Arduino IDE
Arduino versions for Windows, Linux and MAC OSX are available. Select your operating system and start the installation.

**ATTENTION!** We always recommend to download the latest version of Arduino IDE.
Step by step guide for CONTROLLINO software installation

Installation for Arduino IDE Version 1.6.4 or higher

General requirements

- PC with Arduino IDE (1.6.4 or newer) (Windows, Linux, Mac)
- Internet connection

CONTROLLINO library
After starting Arduino IDE navigate to Sketch → Include Library → Manage Libraries (figure 6).

![Navigating to Library Manager](image)

Figure 6: Navigating to Library Manager
In the window that opens called Library Manager type “Controllino” into the search box. Out of the items shown, select CONTROLLINO Library by CONTROLLINO and click "Install" (figure 7).

Figure 7: Library Manager before Installation

An automated process will install the CONTROLLINO Library on your PC. Successful installation is shown with an "INSTALLED" label next to the item name (figure 8).

Figure 8: Library Manager after Installation
Step by step guide for CONTROLLINO hardware installation

Navigate to File → Preferences (Figure 9)

Figure 9: Arduino IDE preferences
Copy-paste the following link into the field labelled "Additional Boards Manager URLs:" (Figure 10) and press "OK" button.

https://raw.githubusercontent.com/CONTROLLINO-PLC/CONTROLLINO_Library/master/Boards/package_ControllinoHardware_index.json

Figure 10: Arduino IDE preferences updated
Then navigate to Tools → Board: "Arduino (name of your last used board)" → Boards Manager (figure 11).

Figure 11: Navigating to Boards Manager
In the Boards Manager type “Controllino” into the search box. CONTROLLINO Boards will be shown. Click the "Install" button (figure 12).

![Boards Manager before Installation](image)

Figure 12: Boards Manager before Installation

After the automated installer finished its work the item will be labelled "INSTALLED" (figure 13).

![Boards Manager after Installation](image)

Figure 13: Boards Manager after Installation
Installation successful

Successful installation can easily be seen. The CONTROLLINO library package will install CONTROLLINO specific examples (figure 14).

Figure 14: CONTROLLINO Examples
The CONTROLLINO Hardware package will allow you to see and select CONTROLLINO boards now (figure 15).

Figure 15: CONTROLLINO Boards
Service and Maintenance

This product is free of maintenance. For cleaning of the housing please use a dry, soft and clean cloth. Under no circumstances use aggressive detergent or chemical solvents, because they may damage the housing (e.g. cause discolorations).

Disposal

At the end of its lifespan, please dispose of this product according to current legal regulations.

Figure 16

Imprint

This instruction manual is published by CONELCOM GmbH, Trientlgasse 18c, 6020 Innsbruck, Austria (http://www.controllino.biz). All rights, including the copyrights of translation reserved. Reproductions of any kind, e.g. photocopies, microfilming, recordings or the capturing in electronic data processing facilities require the written approval of the publisher. Reproduction, also partly, is prohibited. This instruction manual corresponds to the technical state at the time of printing. Subject to change in technology and equipment.

© Copyright 2016 by CONELCOM GmbH.